
Activity Overview
In this activity, you’ll explore using an inertial measurement unit, or IMU, to measure 
movement. An IMU is a device that combines data from multiple sensors such as 
accelerometers, gyroscopes, and sometimes magnetometers. The IMU that you’ll be using is 
a six-axis IMU, which means it can measure linear motion in three planes as well as rotational 
motion about three axes. More specifically, this activity was written for the Grove 6-Axis 
Accelerometer & Gyroscope LSM6DS3 sensor. However, because that is a mouthful to say, it will 
mainly be referred to as the IMU throughout this guide.

You’ll start by exploring the types of data that the IMU can provide by simply connecting the 
IMU to PRIZM®. You’ll then upload and run an example sketch that prints data to the Arduino 
serial monitor or serial plotter so you can see how the IMU’s accelerometer and gyroscope 
react to movement. Following this, you’ll attach the IMU to the TaskBot and use it for crash 
detection and for making perfect 90-degree turns.

Parts Needed
To complete this activity, each team will need the following items: 

• Fully assembled PRIZM TaskBot

• Grove 6-Axis Accelerometer & Gyroscope LSM6DS3 sensor

• https://wiki.seeedstudio.com/Grove-6-Axis_AccelerometerAndGyroscope/

• USB cable

• Charged TETRIX® 12-volt battery

• Computer with the following installed:

• Arduino Software (IDE) with Arduino libraries for TETRIX PRIZM and for TETRIX IMU 
LSM6DS3 Sensor

• Both libraries can be downloaded from the Pitsco website  
at Pitsco.com/TETRIX-PRIZM-Robotics-Controller.

Activity
TETRIX MAX IMU Extension 
Activity

Difficulty
Medium

Class Time
90 minutes

Grade Level
• Middle school

• High school

Learning Focus
• I2C sensors

• Programming/coding

• Dynamics of motion
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Before You Begin
Before you begin this activity, you’ll need to install the TETRIX IMU LSM6DS3 Sensor Library. 
There are two methods of installing a library into the Arduino Software (IDE).

Importing a .zip Library
In the Arduino Software (IDE), navigate to Sketch > Include Library. From the drop-down 
menu, select Add .ZIP Library.

You will be prompted to select the library you would like to add. Navigate to the location 
where you saved the TETRIX IMU LSM6DS3 Sensor Library. Select and open the  
TETRIX_IMU_LSM6DS3.zip file.

Return to the Sketch > Include Library menu. You should now see the TETRIX_IMU_LSM6DS3 
library near the bottom of the drop-down menu. It is ready to be used. However, the example 
sketches used in this activity might not be available until the Arduino Software (IDE) has been 
restarted.

Manual Installation
To install the TETRIX IMU library manually, follow the instructions provided in the PRIZM 
Programming Guide’s Software Setup section.
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Building the Knowledge Base
An IMU measures the motion of an object, and kinematics is the branch of physics that deals 
with the motion of objects. There are several quantities used to describe an object’s motion. 
For example: 

• Displacement is the distance an object moves from one position to another. If a sprinter 
ran the 100-meter dash, then the sprinter’s displacement would be 100 meters.

• Velocity is the change in displacement over time and is closely related to speed. If 
the sprinter ran the 100-meter dash in 10 seconds, the sprinter’s velocity would be 10 
meters per second toward the finish line.

• Acceleration is the change in velocity over time. The sprinter starts at the starting line 
with a velocity of 0 meters per second. If two seconds after the race starts the sprinter 
is moving at a velocity of 10 meters per second, then the sprinter’s acceleration for 
those two seconds would be 5 meters per second per second (or 5 meters per second 
squared) toward the finish line.

The accelerometer in the IMU measures motion in three different directions or planes – side-
to-side motion, forward-and-back motion, and up-and-down motion. In order to describe 
an object’s motion, it is helpful to use a coordinate system. You might be familiar with the 
Cartesian coordinate system from math class. Usually, the x-axis goes left to right while the 
y-axis goes up and down. An object’s position is described by an ordered pair where the x 
position is listed first followed by the y position. For example, (3, 2) is a point at position 3 on 
the x-axis and 2 on the y-axis.

The IMU uses a similar system except that it has three axes rather than two. The z-axis gives a 
third dimension. It crosses the x- and y-axes at the origin and usually is shown going up. With 
this coordinate system, an object’s position or motion can be described using three values – 
one for the x direction, one for the y direction, and one for the z direction.

When dealing with coordinate systems, it’s important to know how they are oriented. Hold 
the IMU with the cable connector toward you and with the cable coming up; you should see 
the orientation information printed in the bottom-left corner. In this orientation, side-to-side 
movement will register on the x-axis. Forward-and-backward movement will register on the 
y-axis. Up-and-down movement will register on the z-axis.

Note: The quantities that describe 
motion are considered vector 
quantities. Vectors have two 
values – a magnitude (or value) 
and a direction. Direction can be 
described in a lot of ways such as 
north, south, east, west, up, down, 
right, left, forward, backward, and 
so on. In fact, you could describe 
the sprinter’s velocity as 10 m/s 
toward the finish line. You could 
even describe his acceleration as  
5 m/s² away from the starting line.

100 m
10 s

= 10 m/s

10 m/s – 0 m/s
2 s

= 5 m/s2
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Note: Notice on the IMU there is 
a circle with a dot in the middle 
where the x and y arrows intersect. 
This symbol indicates the z-axis and 
represents the tip of an arrow as if 
the arrow is pointing out at you.

While its accelerometer measures linear motion in three directions, the IMU also has a three-
axis gyroscope that can measure rotational motion. It is harder to describe rotational motion 
direction in terms of x, y, and z because direction is always changing. Instead, rotational motion 
is described in terms of pitch, roll, and yaw.

• Pitch is rotation around the x-axis (usually front-to-back rotation).

• Roll is rotation around the y-axis (usually side-to-side rotation).

• Yaw is rotation around the z-axis (usually spinning rotation).

You’ll explore these concepts more as you experiment with the IMU.

Activity Setup
For this activity, you’ll need to connect your PRIZM controller to a TETRIX 12-volt battery using 
the TETRIX on/off switch. Then, connect the IMU to the I2C port on PRIZM. Flip the on/off 
switch to turn on PRIZM.

z (yaw)

y (roll)

x (pitch)

4

TETRIX MAX IMU Extension ActivityLesson Guide



Opening the Sketch
Launch the Arduino Software (IDE). The TETRIX IMU library includes a few example sketches to 
help you learn how to use the IMU. Open the Sensor_Test sketch by selecting File > Examples 
> TETRIX_TACTILE > PRIZM_LSM6SD3_IMU_Sensor_Test. The sketch will open in a new 
sketch window.

Executing the Code
The IMU can provide all kinds of data about an object’s motion. In the Sensor_Test sketch, 
scroll down to the void loop() function. You should see nine different lines of code that start 
with the symbol for a code comment (//).
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Each of these lines of code is a function call that is basically turned off. Each function collects 
and reports a different type of data from the IMU. A function can be turned on by deleting the 
// in front of the function call.  When you do this, you should notice the text for the function 
call change color from gray to black.

There are no other commands in the void loop() function, so in order for the sketch to do 
something, one of these functions must be turned on. Start by deleting the // in front of the 
plotAccelRaw() function. This will cause the sketch to jump to the plotAccelRaw() function, 
which is down below the void loop().

The code for the plotAccelRaw() function will be discussed in the Moving Forward section later. 
For now, connect the PRIZM controller to the computer using the USB cable. With the PRIZM on, 
make sure to select the correct port in the Tools menu of the Arduino Software (IDE). Upload the 
example sketch to the PRIZM controller. When the code is uploaded, the green LED with light up 
indicating the code is ready to execute. 

From the Tools menu, launch the serial monitor. This will allow you to observe the data from the 
IMU as you experiment. Press the green Start button on the PRIZM controller. Watch the serial 
monitor as you move the IMU in different directions. You should see a bunch of numbers appear.
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The numbers displayed in the serial monitor probably don’t mean a whole lot right now. Plus, 
they scroll so fast, they are hard to read. The Arduino Software (IDE) has another tool that will 
be more useful for viewing data from the IMU. The serial plotter tool automatically graphs 
the data from the IMU over time. Press PRIZM’s red Stop/Reset button. Then, close the serial 
monitor window. 

From the Tools menu, select Serial Plotter. Press PRIZM’s green Start button to execute the 
code again. The serial plotter should start graphing the data from the IMU. Shake the IMU 
side to side. Then, move the IMU up and down. Finally, move the IMU forward and backward. 
Notice how the graph changes with each type of motion.

Each line on the graph represents a different axis. The blue line should represent motion in the 
x-axis, which is side to side. The red line should represent motion in the y-axis, which is forward 
and backward. The green line represents motion in the z-axis, which is up and down.

Try running different functions in the sketch by adding and removing the // symbols in front 
of each function call. After modifying the sketch to run a different function, you’ll need to 
re-upload the sketch to PRIZM. Run the sketch and look at the data in the serial plotter. When 
you turn on a function, make sure you turn off the others. You should run only one function at 
a time.
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Moving Forward
The code for this sketch starts by including two libraries – the PRIZM library and the LSM6DS3 
library for the IMU. These libraries enable you to use the functions and commands associated 
with PRIZM and the IMU.

Next, there are two commands that instantiate (or name) the PRIZM object and the IMU object.

The final section of code before the void setup() function is the variable declaration section. 
There are a lot of variables declared here. Each of these variables will be used in the sketch to 
store different types of data collected by the sensor. There are three types of variables used:

• Float variables hold decimal values. These variables are often used when mathematical 
equations are used to manipulate the data.

• Integer variables hold values between -32,768 and 32,767. Integer variables are used to 
hold the raw data from the IMU. 

• Unsigned long variables hold values between 0 and 4,294,967,295. These variables are 
used to store large numbers such as the number of milliseconds that have elapsed on 
PRIZM’s timer. That is the case with the millisOld variable that is declared here.

The void setup() function starts by setting the value of all the variables to zero. Following 
these commands is the command to start PRIZM when the green Start button is pressed and 
to open serial communication with the computer.

Following these commands are the first two commands for the IMU. The command  
myIMU.setAccelScale(range) sets the range of the accelerometer. The range parameter can 
be either 2, 4, 8, or 16. These numbers represent a range of +/-2, 4, 8, or 16 g. One g is the 
acceleration due to gravity (the rate at which objects accelerate toward Earth), which is 9.8 
m/s2. The command in the sketch sets the range to 2, which means the acceleration range is 
from -19.6 to 19.6 m/s2. The higher the range parameter, the less precise the accelerometer’s 
measurement will be. So, a range of +/-2 g is the smallest range but the most precise 
measurement.
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Similarly, the command myIMU.setGyroScale(range) sets the range that the gyroscope 
measures. In other words, this command sets the maximum rate that the gyroscope can 
measure as the IMU turns. Acceptable range parameters are 250, 500, 1,000, and 2,000 degrees 
per second (DPS). If the parameter is set to 250, as it is in this sketch, then the gyroscope will 
measure a range of -250 to 250 DPS. On the other hand, a range of 2,000 means it will measure 
a range of -2,000 to 2,000 DPS. Like the accelerometer, the higher the range, the less precise 
the measurement. If you have an object that turns slowly, you’d want to use a smaller range 
(either 250 or 500). But if you have an object that turns very quickly, you’d want to use a higher 
range (either 1,000 or 2,000). 

The final command in the void setup() function sets the millisOld variable to the current time 
on PRIZM’s timer in milliseconds. This will allow the sketch to track the amount of time that 
passes between each iteration of the void loop() function so that rates can be calculated.

As mentioned earlier, the void loop() function has several function calls that can be turned 
on or off by uncommenting and commenting each line of code. Each command runs its 
associated function when its comment symbol (//) is removed. The first four functions use data 
from the accelerometer. The next three functions use data from the gyroscope. The 
plotIMU_PitchRollYaw() function uses a combination of both the accelerometer and the 
gyroscope. The plotTemperature() function uses the imbedded temperature sensor. Let’s look 
at each function one at a time.

Note: For comparison, 
TorqueNADO® motors turn at a 
maximum rate of about 720 DPS.
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Note: The axis parameter for 
the myIMU.getAccelRaw(axis) 
command must use a capital X, Y, 
or Z. 

Note: Notice that the same 
command will either print 
information in the serial monitor 
or plot it in the serial plotter based 
on whichever tool is currently 
open. This makes it easy to switch 
between tools without having to 
change the code. However, for the 
serial plotter to work, nothing else 
can be printed other than commas 
to separate each value. In other 
words, you can’t print data labels to 
the serial monitor and still use the 
serial plotter.

Note: You might be wondering why 
the z-axis plot is showing a positive 
value rather than a negative value if 
gravity is pulling the accelerometer 
down. Recall that IMU stands for 
inertial measurement unit. The 
IMU is actually measuring inertia 
rather than acceleration. Inertia is 
the tendency of an object to resist 
changes in motion. It always acts 
in the opposite direction of the 
force being applied. So, if gravity 
pulls down, the IMU will measure a 
positive value on the z-axis. If you 
push the IMU to the right, the IMU 
will read a negative value on the 
x-axis.

plotAccelRaw() Function
This function simply gathers the raw data from the accelerometer. The command 
myIMU.getAccelRaw(axis) gets the raw data for the x-, y-, or z-axis, whichever is put in 
parentheses. Notice that this command is executed three times, once for each axis, and the 
data is stored in an associated variable – either accX, accY, or accZ. When the data is stored in 
these variables, it is either printed to the serial monitor, where each variable is separated by 
commas, or plotted in the serial plotter, where commas are used to separate each value into its 
own line on the graph.

Run this function on PRIZM and launch the serial monitor. You should notice that the plot lines 
for the x-axis (blue line) and y-axis (red line) are near zero. The line for the z-axis (green line) is 
much higher. This is because the z-axis is up and down, and the force of gravity is pulling down 
on the accelerometer. 

Because this is raw data from the sensor, the actual values don’t have any meaning other than 
in relation to each other. In other words, the data is not displayed in any kind of standard units 
for acceleration.
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plotAccelAngle() Function
In the void loop() function, uncomment this function and make sure all others are commented 
out. That should make this the only function that gets executed. Upload the modified sketch to 
PRIZM. Run the program and watch the serial plotter as you tilt the IMU left, right, forward, and 
backward.

This function plots the direction of movement (tilt) as an angle from the x- and y-axes using 
data from the accelerometer. The accelerometer can measure these angles by using gravity, 
which pulls straight down on the accelerometer, as a reference. When the IMU is tilted side to 
side, it measures the angle of tilt from the x-axis. When the IMU is tilted forward or backward, it 
measures the angle of tilt from the y-axis. The command myIMU.getAccelAngle(axis) gets the 
angle of tilt from the x- or y-axis, depending on which is put in parentheses as the parameter. 

In the function, this command is used twice to get the angle data for both the x- and y-axes, 
and the data is stored in the accAngleX and accAngleY variables. The angles will range from 
-180 to 180 degrees. The angle variables are then printed to either the serial monitor or the 
serial plotter.

Notice that the accelerometer cannot return angle measurements from the z-axis – in other 
words, when the IMU is not tilted, but simply spun to face a different direction. The z-axis is 
parallel to the pull of gravity, so gravity acts the same on the accelerometer no matter how the 
IMU is spun. Because the accelerometer can’t use gravity as a reference, it can’t measure the 
angle it has moved from the z-axis.
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plotAccelGforce() Function
This function measures the force applied to the accelerometer in terms of g-force. One g is 
equal to force of gravity on Earth’s surface. Perhaps you’ve ridden on a roller coaster where 
you are lifted out of your seat as you go over a hill. At this point, you feel weightless and are 
experiencing 0 g. At the bottom of the roller coaster hill, you feel pressed down into the seat 
and feel heavy. If you felt twice as heavy as you normally do, you’d be experiencing a force of 
2 g.

The IMU can measure g-force in any axis. The command myIMU.getAccelG(axis) is used to 
return the g-force on whichever axis (x, y, or z) is put in parentheses as the parameter.

In the void loop() function, uncomment the plotAccelGforce() function call and make 
sure all others are commented out. Upload the modified sketch to PRIZM. Run the program 
and watch serial plotter as you move the IMU. If the IMU is flat and not moving, you should 
notice the green line measures 1 g because gravity is pulling down on the accelerometer. You 
should also notice that quick movements produce sharp spikes in the graphed lines while 
slower movements produce more curved lines.

The range of the g-force measurements depend on the range set in the 
myIMU.setAccelScale() command in the void setup() function. Recall that you can set the 
range to +/-2, 4, 8, or 16 g. The higher the range, the less precise the g-force measurement 
will be.

Note: Newton’s second law of 
motion can be summarized by this 
equation: 

Force = Mass • Acceleration

Since the IMU can measure 
acceleration and its mass is known, 
then it can also measure force.
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plotAccelRate() Function
In the sketch, go back to the void loop() function and uncomment the plotAccelRate() function 
call. Make sure all other function calls are commented out. Upload the sketch to PRIZM, run the 
program, and watch the serial plotter graph the data as you move the IMU.

This function is similar to the plotAccelGforce() function. It uses the same command,  
myIMU.getAccelG(axis), to measure the g-force in the x-, y-, or z-axis. However, in this function, 
the g-force returned by the IMU is multiplied by 9.8 m/s2, which is the acceleration due to 
gravity. The acceleration due to gravity is the rate at which objects fall on Earth. Therefore, 
the acceleration data that is stored in the accGx, accGy, and accGz variables is the actual 
acceleration of the IMU measured in the standard international (SI) unit of meters per second 
squared (m/s²). Having the acceleration data in SI units is useful because now you can compare 
the data to other acceleration measurements that were not taken by this IMU.
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plotGyroRaw() Function
This function returns the raw data from the gyroscope sensor on the IMU. In the void loop() 
function, uncomment this function call and make sure all other are commented out. Upload the 
sketch to PRIZM, run the sketch, and observe the data in the serial plotter as you rotate the IMU. 

As you rotate the IMU side to side, you should see the red line jump up and down. Remember 
that this side-to-side motion is actually a rotation around the y-axis. Next, rotate the IMU front 
to back. This is rotation around the x-axis, so you should see the blue line move up and down. 
Finally, lay the IMU flat and rotate the IMU as if spinning it. This is rotation around the z-axis, so 
you should see the green line move up and down.

As the gyroscope measures rotations around the x-, y-, and z-axes, clockwise rotations will have 
positive values while counterclockwise rotations will have negative values.

In the plotGyroRaw() function, the command to get the raw data from the gyroscope is 
myIMU.getGyroRaw(axis) where the axis parameter can be either X, Y, or Z. This command 
is run three times, once for each axis, and the data is stored in the gyroX, gyroY, and gyroZ 
variables. Like the raw data for the accelerometer, the values returned by this command don’t 
have any meaning other than in relation to each other. In other words, the data is not displayed 
in any kind of standard units for rotational motion.

Note: Recall that rotation around the 
x-axis is called pitch, rotation around 
the y-axis is called roll, and rotation 
around z-axis is called yaw.

14

TETRIX MAX IMU Extension ActivityLesson Guide



plotGyroRate() Function
Using the gyroscope, the IMU not only can measure rotation but also can measure how fast the 
IMU is rotating. The plotGyroRate() function uses the command myIMU.getGyroRate(axis) to 
get the angular rate of rotation in degrees per second for the x, y, or z-axis. In this function, the 
angular rotation rates for all three axes are gathered from the IMU and stored in the gyroDPSx, 
gyroDPSy, and gyroDPSz variables.

Recall that one full rotation is equal to 360 degrees. So, if the IMU rotates one time in one 
second, then the angular rate of rotation is 360 degrees per second (DPS). Try this function by 
uncommenting the function call in the void loop() function and making sure all other function 
calls are commented out. Upload the sketch to PRIZM, run the program, and observe the serial 
plotter as you rotate the IMU. Notice that slow rotations have small DPS measurements while fast 
rotations have high DPS measurements.

Note: Like the raw data, angular 
rate data from the gyroscope will 
have positive values for clockwise 
rotations and negative values for 
counterclockwise rotations.
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plotGyroAngle() Function
The gyroscope can also be used to measure the angle that the IMU has rotated. The 
plotGyroAngle() function is a little more complicated because it involves doing some math. 
Recall that velocity in a straight line is equal to distance divided by time (v = d / t). In the same 
way, rotational velocity is equal to the distance an object rotates divided by the time of rotation. 
Use algebra to rearrange this equation; the rotational distance is equal to the rotational velocity 
times time (d = v • t). The IMU has a built-in command for measuring the rotational velocity, and 
PRIZM’s internal timer can be used to measure time.

The first two lines of code in this function are used to determine time. In the first line, the 
variable dt is set to the current time on PRIZM’s timer using the millis() command subtracted 
by the previously stored time on the timer. This gives a time interval in milliseconds between 
measurements. This value is then divided by 1,000 to convert the time interval to seconds. After 
the time interval has been calculated, then the millisOld = millis() command starts a new time 
interval.

The next three lines of code are the equations that determine the angle of rotation. These 
equations take the form of the distance equation, d = v • t where v is the angular velocity 
measured by the IMU using the myIMU.getGyroRate(axis) command, and time is represented 
by the dt variable. However, this determines only the change in the angle, not the actual angle. 
So, to get the actual angle of rotation, the previous angle measurement is added to the change 
in the angle measurement.

Lastly, the gyroAngleX, gyroAngleY, and gyroAngleZ variables that hold the angle of rotation 
for the x-, y-, and z-axes are printed to the serial monitor or plotted in the serial plotter.

Note: In physics, the variable dt 
often stands for delta time. Delta 
is a Greek letter used to represent 
change. So, dt literally means 
change in time. Sometimes, dt 
is written as Δd, using the Greek 
symbol for delta.

Note: Recall that millisOld was 
declared as an unsigned long 
variable at the beginning of the 
sketch, meaning it could store up 
to 4,294,967,295 milliseconds of 
time. That means the sketch could 
run continuously for almost 50 days 
before it runs out of storage space.
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If you haven’t yet, try this function by uncommenting the plotGyroAngle() function call in the 
void loop() function and commenting out the other function calls. Upload the changed sketch, 
run the code, launch the serial plotter, and watch as you rotate the IMU. 

After a few seconds, you should see the graphs move away from the 0 line. This is called 
drift and is the downside of using the gyroscope to measure the angle of rotation. While the 
accelerometer can use gravity to reference which way is down, the gyroscope has no reference. 
So, after a short period of time, the angle measurements can become skewed. However, one 
benefit of using the gyroscope to measure rotation angles is that the gyroscope does not 
measure as much vibration as the accelerometer. The lines graphed in the serial plotter should 
be much smoother than the graphs using the accelerometer data.
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plotIMU_PitchRollYaw() Function
The great advantage of an IMU is being able to combine data from both the accelerometer and 
the gyroscope to get the best of both sensors. That’s what is happening in the  
plotIMU_PitchRollYaw() function. The accelerometer measures the angle of tilt using gravity as 
a reference. The gyroscope measures the rate of rotation over time. Uncomment this function call 
in the void loop() function and make sure all others are commented out. Upload the modified 
sketch, open the serial plotter, run the program, and watch as the serial plotter graphs the pitch, 
roll, and yaw of the IMU using data from both the accelerometer and the gyroscope.

The plotIMU_PitchRollYaw() function starts like the previous function. The first two lines of 
code are used to determine the time interval between measurements in seconds. The variable dt 
holds the time interval.

The next three lines of code determine the pitch, roll, and yaw by combining data from both the 
gyroscope and accelerometer. Starting with the equation for pitch, notice that it can be broken 
down into two parts – a gyroscope part and an accelerometer part. The value for the pitch will be 
95% from the gyroscope and 5% from the accelerometer. These percentages can be adjusted to 
give more influence to one sensor or the other, but they should always add up to 100%.

The gyroscope part of the equation is very similar to what was used in the plotGyroAngle() 
function. The change in the angle of rotation is equal to the rate of rotation times the time of 
rotation. The rate of rotation comes from the gyroscope using the myIMU.getGyroRate(X) 
command. The time of rotation is stored in the dt variable. This gives the change in the angle; 
to get the actual angle in degrees, the previous value of the pitch is added. This entire quantity 
inside parentheses is then multiplied by 0.95 to give the gyroscope 95% influence over the total 
value of the pitch.

Recall that the accelerometer measures the angle of tilt. So, for the accelerometer part of the 
equation, the command myIMU.getAccelAngle(Y) gets the angle of acceleration along the 
y-axis. This angle is then multiplied by 0.05 to give the accelerometer data 5% influence over the 
overall pitch value.

By combining data from the gyroscope and accelerometer, you get the best of both sensors. 
The gyroscope is able to filter out a lot of the vibration data from the accelerometer and the 
accelerometer is able to correct for gyroscope drift.

The roll equation follows the exact same format with the gyroscope having 95% influence and 
the accelerometer having 5% influence.

The equation for yaw uses data only from the gyroscope because the accelerometer cannot 
measure rotation around the z-axis. Therefore, the yaw measurement is still likely to have drift.

Finally, the pitch, roll, and yaw variables are printed to the serial monitor or plotted in the serial 
plotter.

Note: Recall that pitch is rotation 
around the x-axis, roll is rotation 
around the y-axis, and yaw is 
rotation round the z-axis.

Note: In the equation, notice 
that gyroscope rate from the 
x-axis is combined with the 
acceleration angle from the 
y-axis. This is because rotation 
around the x-axis (pitch) results 
in acceleration along the y-axis. 
Therefore, gyroscope data 
around the x-axis must be 
combined with accelerometer 
data for the y-axis.

In the same way, rotation 
around the y-axis (roll) results 
in acceleration in the x-axis. 
So, gyroscope data around the 
y-axis must be combined with 
accelerometer data for the x-axis.
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plotTemperature() Function
The IMU also has a built-in temperature sensor that can report the temperature in Fahrenheit 
and Celsius. Uncomment the plotTemperature() function call in the void loop() function and 
make sure all other function calls are commented out. Upload the modified sketch, open the 
serial plotter, run the program, and watch as the serial plotter graphs the temperature in both 
Fahrenheit and Celsius. You can change the temperature of the IMU by covering it with your 
hand or blowing on it.

In the plotTemperature() function, there are two commands used to read the temperature from 
the IMU and store it in a variable. The command myIMU.getTempC() returns the temperature in 
Celsius and the command myIMU.getTempF() returns the temperature in Fahrenheit.

Real-World Connection
IMUs are pretty common sensors in our world today. Almost all smartphones have IMUs that 
determine how you are holding your phone so it can rotate the screen accordingly. Games and 
apps on your phone or other mobile devices utilize an IMU to detect which way you are tilting 
the device. This allows you to steer vehicles, guide marbles through mazes, and hit virtual golf 
balls. Some games even use an IMU to detect vibrations from tapping to determine how fast you 
run in the game. Alternative reality and virtual reality goggles use IMUs to determine which way 
you are looking. Wearable fitness trackers use IMUs to detect movement and can help the tracker 
count the number of steps you’ve taken.

After the temperature is stored in the tempC and tempF variables, the readings are printed to 
either the serial monitor or the serial plotter.
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Step 1 Parts Needed

Building Interlude: Adding the IMU to the TaskBot

Note: The servo and flag mechanism at the 
back of the bot will not be used for this activity. 
It is your decision whether you remove the flag 
mechanism or not.

Step 1.0
If your TaskBot has the ultrasonic and line finder sensors attached to the 
front, you’ll need to remove these components to make room for the IMU.

Tip: Instructions for building the TaskBot 
can be found in the TETRIX PRIZM Robotics 
Controller Programming Guide that came 
with your TETRIX set.

Assembled TaskBot
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Partial assembly should look like this.

Step 2 Parts Needed

Nuts, Screws, & Fasteners
Part No.  Part Name Quantity
39094 Kep Nut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
39098 Socket Head Cap Screw 6-32 x 5/16" . . . . . . . . . . . . . . . . . . . . . 2

Electronics & Control
Part No.  Part Name Quantity
43076 Line Finder Sensor Mount  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
NA Grove 6-Axis Accelerometer & Gyroscope
 LSM6DS3 sensor (IMU).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
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Step 2.0

Detail
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Finished assembly should look like this.
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Building the Knowledge Base
As you already saw in the first example sketch, the IMU can provide all kinds of data about the 
sensor’s movement and orientation. When the IMU is attached to a robot, its data can be used 
to automatically control the robot. 

Control theory is a branch of engineering that uses mathematics to affect the behavior of a 
system or robot. In control theory, a controller affects the behavior of the system. On your 
TaskBot, the PRIZM will act as the controller that affects the robot’s behavior. A feedback loop 
will gather data from the IMU. This data is then analyzed mathematically and compared to a 
reference value. This comparison allows the system to determine a measurement error. This 
error is then fed back into the PRIZM controller, which causes the robot to change its behavior. 

Control Theory

Reference

Controller System

Sensor

Measured
Error

Measured
Output

System
Input

System
Output
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Math 
Function Purpose Code Examples

Absolute 
Value

Returns the magnitude 
of a number regardless 
of its sign.

 

 answer = 5

Power

Returns a repeated 
multiplication of a value 
(base) when multiplied 
a specified number of 
times (exponent).

 

 answer = 34 = 81

Square 
Root

Returns a number that 
when multiplied by 
itself produces a given 
quantity.

 

 answer = 6

Sine

Returns the ratio of the 
length of the opposite 
side of a triangle to the 
hypotenuse for a given 
angle of a right triangle 
in radians.

 

 answer = 0.00

Cosine

Returns the ratio of the 
length of the adjacent 
side of a triangle to the 
hypotenuse for a given 
angle of a right triangle 
in radians.

 

 answer = -1.00

Tangent

Returns the ratio of the 
length of the opposite 
side of a triangle to the 
adjacent side for a given 
angle of a right triangle 
in radians.

 

 answer = 0.00

Constrain

Limits a specified value 
to a given range of 
values.

 

 answer = 100

Map

Linearly adjusts a value 
from an input range to 
an output range.

 

 answer = 50

Random
Returns a random 
number in a specified 
range.

 

 answer = 7

Control theory can be a complex area of study with some advanced levels of mathematics. For example, one very accurate and 
common method of controlling a system is called proportional, integral, derivative (PID) control and involves using calculus to 
analyze data. We won’t get into PID control in this activity, but we will use some basic math to analyze the data collected by the IMU. 

The Arduino Software (IDE) has several built-in math functions that allow for manipulating data and variables. This table shows some 
common math functions.

The IMU_TaskBot_Crash sketch you are about to run on the TaskBot uses the absolute value function when measuring the g-force 
on the IMU. This allows the robot to detect forward collisions (negative values on the y-axis) or rear collisions (positive values on the 
y-axis).
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Opening the Sketch
Launch the Arduino Software (IDE). Open the IMU_TaskBot_Crash sketch by selecting File 
> Examples > TETRIX_TACTILE > PRIZM_LSM6SD3_IMU_TaskBot_Crash. The sketch will 
open in a new sketch window.

Executing the Code
Connect the PRIZM controller to the computer using the USB cable. With the PRIZM on, make 
sure to select the correct port in the Tools menu of the Arduino Software (IDE). Upload the 
IMU_TaskBot_Crash sketch to the PRIZM. When the code is uploaded, the green LED will light 
up indicating the code is ready to execute. 

Place the TaskBot on the floor facing an obstacle. Press the green Start button on the PRIZM 
controller. Watch the TaskBot as it drives forward and bumps into the obstacle. When the 
g-force from the crash exceeds the threshold set for determining a crash, the TaskBot will 
back up. It then uses the gyroscope to make a 90-degree turn. After the turn is complete, the 
TaskBot continues in the new direction until it crashes into another obstacle.

Note: The first time you run the 
sketch, you might notice the 
TaskBot rotates more than 90 
degrees after a crash. This is due to 
how the IMU library uses historical 
data to calibrate the IMU. To resolve 
this, simply stop the program by 
pushing the PRIZM’s red Stop/Reset 
button. Then, run the sketch again. 

TETRIX
bin

Wall
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Moving Forward
The code for this sketch starts by including the PRIZM library and the LSM6DS3 library for the IMU. 
Next, there are two commands that instantiate (or name) the PRIZM object and the IMU object.

Then, the variables that are used in the sketch are declared and assigned value. Variables that 
hold data from the IMU are float variables that will be able to store decimal values. This table 
describes how each variable is used.

In the void setup() function, the first line of code is the command to start PRIZM when the 
green Start button is pressed, and the second line opens serial communication with the 
computer.

Variable Type Purpose

gForceCrash Float

Stores the threshold for determining a crash. Increasing 
this value means the robot will detect only harder crashes. 
Decreasing the value means the robot will detect smaller 
crashes.

accelGy Float

Stores the measured g-force from the IMU in the y 
direction (front to back of the robot). This value gets 
compared to the gForceCrash variable to determine if a 
crash has occurred.

yaw Float Stores the yaw of the robot (rotation around the z-axis) for 
making a 90-degree turn after a crash.

targetYaw Float
Stores 90 degrees more than the yaw measurement at the 
start of the turn. The robot continues to turn while the yaw 
is less than the targetYaw.

yawDriftRate Float Stores the drift rate of the yaw. This value is taken into 
account when determining the yaw.

dt Float Stores the change in time from one IMU measurement to 
the next.

millisOld Unsigned Long Stores the time at the previous yaw measurement. It is 
used to determine the dt variable.

mPower Integer Stores the motor power. Increasing this variable increases 
the speed of the robot, which will cause harder crashes.
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Next are the commands that set the range for the accelerometer and the gyroscope on the 
IMU. The command myIMU.setAccelScale(2) sets the range of the accelerometer to +/-2 g. 
The command myIMU.setGyroScale(250) sets the range that the gyroscope measures to 
+/-250 DPS. A short delay after these two commands gives the IMU time to configure.

Recall that the IMU’s measurement for yaw suffers from drift because the gyroscope has no 
reference in the z direction with which to correct itself. However, by measuring the drift rate 
while the TaskBot remains still, the program can account for the drift later when the TaskBot 
is turning. The myIMU.getGyroRate(Z) command measures the rate of turning around the 
z-axis, and when the robot isn’t moving, this rate is equal to the drift rate. The drift rate is then 
stored in the yawDriftRate variable. A short delay then pauses the sketch before the robot 
starts moving forward.

The next group of commands inverts Motor 1 and then sets the motors to the mPower 
variable so that the TaskBot drives forward. A short delay of 500 milliseconds is needed after 
the command to drive forward. This delay keeps the robot from measuring the acceleration 
change as the robot goes from stationary to driving forward. Without this delay, the robot 
could think that a crash has occurred as the robot starts moving forward.

The void loop() function starts by measuring the g-force in the y direction using the  
myIMU.getAccelG(Y) command. This command is placed inside the abs() function to store 
the absolute value of the g-force in the accelGy variable. When the robot crashes going 
forward, the g-force value will be negative. When the robot crashes in the rear, the g-force 
value will be positive. By taking the absolute value of the g-force measurement, it ensures the 
accelGy variable will be positive, allowing the robot to detect both front and rear collisions. 

When the g-force is measured and stored, a conditional statement is used to compare the 
g-force to the threshold for detecting a crash that was set at the beginning of the sketch. As 
long as the g-force stored in the accelGy variable is less than or equal to the gForceCrash 
variable, then the TaskBot will continue to drive forward. But if the accelGy variable is greater 
than the gForceCrash variable, then a crash has been detected and the crash() function is 
called. At this point, the sketch jumps down to the crash() function and executes the code for 
when a crash is detected.

When a crash has occurred, the first thing that is executed from the crash() function is the 
TaskBot backs up for 1.5 seconds (1,500 milliseconds), stops, and then waits for 1 second for 
the robot to come to a complete stop.

Note: The accelerometer range 
can be set to +/-2, 4, 8, or 16 g. The 
higher the range, the less precise 
the measurement will be. 

The gyroscope range can be set to 
+/-250, 500, 1,000, or 2,000. Again, 
the higher the range, the less 
precise the measurement will be.

Note: The print commands for the 
serial monitor are commented out 
in this sketch. This is because it’s 
difficult to run the sketch when 
the TaskBot is connected to the 
computer with the USB cable. 
However, for testing, you can prop 
up the wheels of the TaskBot so 
they don’t touch the table, connect 
the USB cable, uncomment the 
print commands, and monitor the 
IMU data in the serial monitor.
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The next line of code updates the yaw drift rate in case it has changed since it was last 
measured.

Before the TaskBot starts its turn, the yaw variable is reset to 0. This makes the direction the 
TaskBot is facing 0 degrees. Then, the targetYaw variable is set to 90. This makes the TaskBot 
turn an angle of 90 degrees to the right. You can change the targetYaw to any angle. For 
example, to make a 45-degree turn, you’d set the targetYaw variable to 45. Leave targetYaw 
at 90 for now.

After the yaw and target yaw are set, the TaskBot starts its turn by moving Motor 1 forward at 
the mPower variable and Motor 2 backward at the negative mPower variable. The time from 
PRIZM’s timer is then stored in the millisOld variable.

When the TaskBot starts the 90-degree turn, the sketch uses a while loop to compare the 
yaw measurement from the gyroscope to the targetYaw variable. As long as yaw is less than 
targetYaw, the TaskBot will continue to turn. 

Inside the while loop, the yaw variable needs to be continuously recalculated as the TaskBot 
turns. To do this, the time between yaw measurements needs to be calculated and stored 
in the dt variable. The time interval is calculated by subtracting the time at the previous 
measurement (millisOld) from the current time (millis) and then dividing this quantity by 
1,000 to convert the time to seconds. Then, the current time on PRIZM’s timer is stored in the 
millisOld variable to start the next time interval.

The last line inside the while loop calculates the yaw from the gyroscope. This value 
continuously changes as the TaskBot turns. There are two main parts to this equation. The first 
part is the same as how yaw was calculated in other parts of the sketch – the rate of rotation 
about the z-axis using the myIMU.getGyroRate(Z) command is multiplied by the time of 
rotation (dt) and then added to the yaw variable. The second part of the equation determines 
how far the gyroscope has drifted over the time interval by multiplying the yawDriftRate 
variable by the dt variable. This quantity is then added to the yaw calculation to get an 
accurate yaw measurement.
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Because the yaw measurement is now accounting for drift, the TaskBot can make a perfect 
90-degree turn. As soon as the yaw measurement is greater than or equal to the targetYaw 
variable, the sketch will break out of the while loop and continue through the rest of the void 
loop() function.

When the 90-degree turn is complete, the first command after the while loop stops the 
motors by setting the motor powers to 125. After a short delay, the prizm.setMotorPowers() 
command causes the Taskbot to move forward at the mPower variable. Following this a short 
delay of 500 milliseconds allows the accelerometer to resettle as the Taskbot moves forward. 
This way the sudden change in velocity isn’t detected as another crash.

This concludes the crash() called function, and the sketch jumps back up the void loop() 
function. There are no further commands in the void loop() function, so the sketch goes 
back to the beginning of the loop and starts scanning for crashes again using data from the 
accelerometer.

Real-World Connection
One of the most common applications of IMUs is to aid in navigation and maneuvering. For 
example, during flight, airplanes use IMUs to detect changes in pitch, roll, and yaw due to wind 
gusts and turbulence. The plane automatically compensates for these changes by adjusting 
flaps, ailerons, elevators, and the rudder to keep the plane on the correct heading. Two-
wheeled personal transportation devices also use IMUs to help the rider stay balanced. Speed 
and direction are controlled by how far the IMU tilts.

Hacking the Code Activity
Using the examples as a reference, try creating a new sketch to have the TaskBot climb a ramp. 
Use long boards, a desktop, or other flat surface that can be tilted as a ramp. As the TaskBot 
climbs, its speed should slow down according to the steepness of the ramp. This will help the 
robot get better traction. As the robot goes down the ramp, the steeper the incline, the faster 
the speed should be. Have a competition with your friends and classmates to see whose robot 
can climb the steepest ramp.
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